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1. PURPOSE 

This document establishes the procedure for the Centers for Medicare & Medicaid 
Services (CMS) to determine compliance of electronic and information technology (EIT) 
with Section 508 of the Rehabilitation Act of 1973 (29 U.S.C. § 794 (d)), as amended by 
the Workforce Investment Act of 1998 (P.L. 105-220), August 7, 1998.   
 

2. REFERENCES 

• CMS Policy for Section 508 Compliance 
 

3. SCOPE 

This procedure is to be utilized by all CMS employees, contractors, and partners 
developing, procuring, maintaining, or using EIT products or services on behalf of CMS.  
 
Within the FAR 2.101, EIT has the same meaning as "information technology," except 
EIT also includes any equipment or interconnected system or subsystem of equipment 
that is used in the creation, conversion, or duplication of data or information. The term 
EIT, includes, but is not limited to, telecommunication products (such as telephones), 
information kiosks and transaction machines, worldwide websites, multimedia, and office 
equipment (such as copiers and fax machines). 
  
According to OMB Circular A-130, “information technology” is equipment or 
interconnected systems that are used in the automatic acquisitions, storage, manipulation, 
management, movement, control, display, switching, interchange, transmission, or 
reception of data or information. The term includes computers, ancillary equipment, 
software, firmware and similar procedures, services (including support services), and 
related resources. 
  
To further clarify the FAR definition, EIT includes any product used to acquire, store, 
manipulate, or transmit information. This includes software applications and operating 
systems; web-based intranet and internet information and applications such as distance 
learning; telephones and other telecommunications products; information kiosks and 
transaction machines; video equipment and multimedia products that may be distributed 
on videotapes, CDs, DVDs, or the World Wide Web; office products such as 
photocopiers and fax machines; calculators; and computer hardware. 
  
According to the Access Board, EIT does not include any equipment that contains 
embedded information technology that is used as an integral part of the product, but the 
principal function of which is not the acquisition, storage, manipulation, management, 
movement, control, display, switching, interchange, transmission, or reception of data or 
information. Examples of non-EIT include heating, ventilation, and air conditioning 
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(HVAC) equipment such as thermostats or temperature control devices and medical 
equipment where information technology is integral to its operation. 
 

4. ROLES AND RESPONSIBILITIES 

The following entities have specific responsibilities related to the implementation of this 
procedure: 
 
4.A.   All CMS Employees, Agents, and Contractors 

For the purposes of this procedure, all CMS employees, agents, and contractors are 
responsible for ensuring that all content, documents, applications, and files authored, 
owned, developed, maintained, and submitted for publication on CMS’ public-facing 
websites and the CMS intranet or distributed via broadcast emails are Section 508 
compliant in accordance with this procedure. 
 
4.B.   CMS Requesting Officials (Purchase Requestors), Business 

Owners, and/or Project Managers 

For the purposes of this procedure, CMS Requesting Officials (Purchase Requestors), 
Business Owners, and/or Project Managers are responsible for the following activities:  

• Completing the Section 508 Determination & Findings for Purchase Requests 
form for every new purchase request in accordance with Section 5.A. of this 
procedure; 

• Ensuring that an appropriately completed Section 508 Determination & 
Findings for Purchase Requests form is attached to each new purchase request 
(i.e., HHS-393 Form or Credit Card Purchase Authorization Form) before it is 
submitted through the standard CMS procurement process; 

• Reviewing the Access Board standards and determining which Section 508 
Accessibility Standards (36 CFR Part 1194) apply to the specific EIT product or 
service being developed, procured, maintained, or used; 

• Appropriately documenting a Section 508 “General EIT” exception, if determined 
to be applicable, by completing the Section 508 General EIT Exception 
Determination & Findings Certification form in accordance with the 
Procedure: Section 508 Exceptions and attaching the completed form to the 
corresponding purchase request (i.e., HHS-393 Form or Credit Card Purchase 
Authorization Form) before it is submitted through the standard CMS 
procurement process; 

• Conducting market research in accordance with the Procedure: Conducting 
Market Research to identify what EIT products, if any, are available in the 
marketplace to meet the business requirements and associated technical 
provisions of the Access Board’s standards, and appropriately documenting the 
results; 
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• Appropriately documenting a Section 508 “Undue Burden” exception, if 
determined to be applicable, by completing the Section 508 EIT “Undue 
Burden” Exception Determination & Findings Certification form in 
accordance with the Procedure: Section 508 Exceptions and attaching the 
completed form to the corresponding purchase request (i.e., HHS-393 Form or 
Credit Card Purchase Authorization Form) before it is submitted through the 
standard CMS procurement process;  

• Appropriately documenting a Section 508 “Commercial Non-Availability” 
exception, if determined to be applicable, by completing the Section 508 EIT 
“Commercial Non-Availability” Exception Determination & Findings 
Certification form in accordance with the Procedure: Section 508 Exceptions and 
attaching the completed form to the corresponding purchase request (i.e., HHS-
393 Form or Credit Card Purchase Authorization Form) before it is submitted 
through the standard CMS procurement process; 

• Ensuring that Section 508 compliance and accessibility is appropriately addressed 
and evaluated during the life cycle of an EIT product or service that is developed 
(built) or adapted specifically for CMS in accordance with Section 5.B. of this 
procedure; 

• Ensuring that a CMS Section 508 Product Assessment is completed by the 
manufacturer, vendor, or developer for every EIT product or service developed or 
procured by CMS;  

• Ensuring that a CMS Section 508 Product Assessment is completed by the 
manufacturer, vendor, or developer of all legacy EIT products or services that are 
operating in the CMS production environment (e.g., websites, information 
systems, applications, etc.), which have not been previously evaluated for Section 
508 compliance;  

• In collaboration with the business component’s CMS Section 508 Clearance 
Officer and/or the CMS Section 508 Coordinator, developing a remediation plan 
for achieving Section 508 compliance for legacy EIT products that are operating 
in the CMS production environment that are determined to be non-compliant, or 
requesting an applicable Section 508 exception in accordance with the Procedure: 
Section 508 Exceptions; and 

• In collaboration with the business component’s CMS Section 508 Clearance 
Officer and/or the CMS Section 508 Coordinator, reviewing completed CMS 
Section 508 Product Assessments for compliance of the EIT product or service 
with the Section 508 EIT Accessibility Standards.  

 
4.C.   System Developers & System Maintainers 

For the purposes of this procedure, System Developers and System Maintainers are 
responsible for the following: 

• Collaborating with the Business Owner in reviewing and revalidating all of the 
applicable Access Board technical provisions that were documented in the 
Requirements Document and making any necessary adjustments before 

______________________________________________________________________________________ 
Procedure: Determining Section 508 Compliance     3 of 26 

 



  CMS-OIS-PROC-50801-01     July 16, 2008 

establishing the requirements baseline for the EIT product or service to be 
developed (built) or adapted specifically for CMS; 

• Completing a CMS Section 508 Product Assessment for every EIT product or 
service developed (built) or adapted specifically for CMS in accordance with 
Section 5.B. of this procedure; 

• Ensuring that all EIT products or services designed and developed (built) or 
adapted specifically for CMS meet all of the applicable Access Board technical 
provisions that were documented in the Requirements Document and are fully 
tested for Section 508 compliance and accessibility; 

• Ensuring that plans for testing or verifying/validating compliance with the 
applicable technical provisions (Section 508 requirements) are finalized and 
documented in the Test Plan, and that test cases are created to test the Section 508 
requirements, which are documented in the Test Case Specification; 

• Fixing any reported defect in an EIT product or service that was developed (built) 
or adapted specifically for CMS; and 

• Ensuring that Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and 
Portable Document Format (PDF) files that are created for CMS are Section 508 
compliant and accessible in accordance with Sections 5.D., 5.E., 5.F., and 5.G. of 
this procedure. 

     
4.D.   CMS Section 508 Clearance Officer 

For the purposes of this procedure, the CMS Section 508 Clearance Officer is responsible 
for the following: 

• Providing assistance in determining the Section 508 EIT Accessibility Standards 
that apply to the development or procurement of a specific EIT product or service 
for CMS; 

• Providing assistance in evaluating EIT products/services for Section 508 
compliance; 

• Reviewing new purchase requests originating within the CMS business 
component to ensure CMS’ compliance with Federal requirements relative to 
Section 508; 

• Reviewing completed CMS Section 508 Product Assessments within the 
business component and making determinations as to the compliance of the 
associated EIT product or service with the applicable Section 508 accessibility 
standards;  

• Certifying in writing as appropriate that a “General EIT”, “Commercial Non-
Availability”, or “Undue Burden” exception applies to an EIT procurement, if 
determined to be applicable, in accordance with the Procedure: Section 508 
Exceptions; 

• Reviewing electronic communications acquired or created by the CMS business 
component for Section 508 compliance in accordance with applicable Section 508 
accessibility standards before the communications are released; and 
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• Ensuring the development and completion of remediation plans for EIT that is 
identified as being non-compliant with Section 508 and the responsibility of the 
CMS business component. 

 
4.E.   CMS Section 508 Coordinator 

For the purposes of this procedure, the CMS Section 508 Coordinator is responsible for 
the following: 

• Providing assistance in determining the Section 508 EIT Accessibility Standards 
that apply to the development or procurement of a specific EIT product or service 
for CMS; 

• Reviewing completed CMS Section 508 Product Assessments and making 
determinations as to the compliance of the associated EIT product or service with 
the applicable Section 508 EIT Accessibility Standards; 

• Assisting in the development of remediation plans for achieving Section 508 
compliance of non-compliant legacy EIT operating in production; 

• Certifying in writing as appropriate that a “General EIT”, “Commercial Non-
Availability”, or “Undue Burden” exception applies to an EIT procurement, if 
determined to be applicable, in accordance with the Procedure: Section 508 
Exceptions; and 

• Certifying that a developed EIT product is Section 508 compliant or that the 
appropriate Section 508 exception has been fully documented and approved/ 
certified by all required signatories prior to release of the EIT product or service 
into the CMS production environment. 

 
4.F.   Office of Acquisition and Grants Management (OAGM) 

Procurement Officials (Contracting Officers) and Individual 
Credit Card Purchasers 

For the purposes of this procedure, the Procurement Officials (Contracting Officers) in 
the OAGM and Individual Credit Card Purchasers are responsible for the following: 

• Ensuring that a completed Section 508  Determination & Findings for 
Purchase Requests form is attached to each completed purchase request (i.e., 
HHS-393 Form or Credit Card Purchase Authorization Form) and maintained in 
the contract or purchase documentation files for all EIT procurements; and 

• Ensuring that the appropriate form (i.e., Section 508 General EIT Exception 
Determination & Findings Certification, Section 508 EIT “Undue Burden” 
Exception Determination & Findings Certification, or Section 508 EIT 
“Commercial Non-Availability” Exception Determination & Findings 
Certification) is completed and attached to the purchase request (i.e., HHS-393 
Form or Credit Card Purchase Authorization Form) when a Section 508 exception 
is determined to be applicable and is appropriately certified.  
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4.G.   OIS-Designated Testing Resource 

For the purposes of this procedure, the OIS-Designated Testing Resource is responsible 
for testing EIT products or services that are developed (built) or adapted specifically for 
CMS in accordance with the documented Test Plan and corresponding Test Case 
Specification, and recording the results from the testing in a Test Summary Report. 
 
4.H.   Office of Beneficiary Information Services (OBIS) 

For the purposes of this procedure, OBIS is responsible for the following activities: 
• Ensuring that there is a process in place for publishing content on CMS’ public-

facing websites (http://www.cms.hhs.gov/ and http://www.medicare.gov/) and the 
CMS intranet, which is Section 508 compliant in accordance with applicable 
Section 508 accessibility standards and procedures; 

• Ensuring the framework templates for CMS’ public-facing websites and the CMS 
intranet are Section 508 compliant; 

• Performing random audits to verify that content published on CMS’ public-facing 
websites and the CMS intranet are Section 508 compliant; 

• Denying new content from being published on CMS’ public-facing websites and 
the CMS intranet if it is not Section 508 compliant; and 

• Assisting in the development of remediation plans for achieving Section 508 
compliance of non-compliant content published on CMS’ public-facing websites 
and the CMS intranet. 

 

5. PROCEDURE 

The following describes the sequence of steps that comprise the procedure for 
determining compliance with Section 508 of the Rehabilitation Act of 1973, as amended, 
of an EIT product or service that is purchased or developed by CMS.  The steps are listed 
in the sequence in which they generally occur.  There may be cases, however, where the 
sequence will be different (e.g., market research may need to be conducted at an earlier 
point than is listed here, or an “Undue Burden” exception may be able to be certified at 
an earlier stage because of existing knowledge of the marketplace). 
 
5.A.   Purchase Requests  

The following describes the sequence of steps that comprise the procedure for ensuring 
CMS’ compliance with Federal requirements relative to any new purchase request: 
 
STEP 1:  The Requesting Official (Purchase Requestor) completes Section 1 of the 
Section 508 Determination & Findings for Purchase Requests form identifying 
whether or not the business need potentially relates to information technology (IT) as a 
procurement deliverable.    
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If the purchase request does relate to IT, then the Requesting Official (Purchase 
Requestor) indicates as such in Section 1 of the Section 508 Determination & Findings 
for Purchase Requests form, and proceeds to Step 2.   
 
If the purchase request does not relate to IT, then the Requesting Official (Purchase 
Requestor): 

(1.) Completes the certification line for Section 1 of the Section 508 Determination 
& Findings for Purchase Requests form; 

(2.) Reads Sections 2 and 3 of the Section 508 Determination & Findings for 
Purchase Requests form, but does not certify to them; and 

(3.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form to the purchase request (i.e., HHS-393 Form or Credit Card 
Purchase Authorization Form, as applicable) and submits the package through the 
standard CMS procurement process as appropriate, thereby completing the 
procedure for determining Section 508 compliance for the purchase request. 

 
STEP 2:  If the purchase relates to IT, then the Requesting Official (Purchase Requestor) 
completes Section 2 of the Section 508 Determination & Findings for Purchase 
Requests form identifying whether or not the purchase request also qualifies as an EIT 
procurement.  Refer to Section 2 of the Section 508 Determination & Findings for 
Purchase Requests form for a detailed definition of what qualifies as EIT. 
 
If the purchase request does qualify as an EIT procurement, then the Requesting Official 
(Purchase Requestor) indicates as such in Section 2 of the Section 508 Determination & 
Findings for Purchase Requests form, and proceeds to Step 3.   
 
If the purchase request does not relate to IT, then the Requesting Official (Purchase 
Requestor): 

(1.) Completes the certification line for Section 2 of the Section 508  Determination 
& Findings for Purchase Requests form; 

(2.) Reads Section 3 of the Section 508 Determination & Findings for Purchase 
Requests form, but does not certify to it; and 

(3.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form to the purchase request (i.e., HHS-393 Form or Credit Card 
Purchase Authorization Form, as applicable) and submits the package through the 
standard CMS procurement process as appropriate, thereby completing the 
procedure for determining Section 508 compliance for the purchase request. 

 
STEP 3:  If the purchase qualifies as being for EIT, then the Requesting Official 
(Purchase Requestor) completes Section 3 of the Section 508 Determination & 
Findings for Purchase Requests form identifying whether or not the qualifying EIT 
falls under one of the “General EIT” exceptions. 
 
If the purchase request does not meet any of the criteria for a “General EIT” exception, 
then the Requesting Official (Purchase Requestor) indicates as such in Section 3 of the 
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Section 508 Determination & Findings for Purchase Requests form, and proceeds to 
Step 4.   
 
If the purchase request does meet the criteria to be considered a “General EIT” exception, 
then the Requesting Official (Purchase Requestor): 

(1.) Identifies which exception(s) are applicable and completes the certification line 
for Section 3 of the Section 508  Determination & Findings for Purchase 
Requests form;  

(2.) Completes the Section 508 General EIT Exception Determination & Findings 
Certification form in accordance with the Procedure: Section 508 Exceptions; 
and 

(3.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form and the completed Section 508 General EIT Exception 
Determination & Findings Certification form to the purchase request (i.e., 
HHS-393 Form or Credit Card Purchase Authorization Form, as applicable) and 
submits the package through the standard CMS procurement process as 
appropriate, thereby completing the procedure for determining Section 508 
compliance for the purchase request. 

 
STEP 4:  If the purchase qualifies as being for EIT and none of the “General EIT” 
exceptions are applicable, then the Requesting Official (Purchase Requestor) completes 
Section 4 of the Section 508 Determination & Findings for Purchase Requests form 
identifying whether or not any of the Access Board’s technical provisions (36 CFR 
Subparts 1194.21 through 1194.41) are applicable to the purchase request.   
 
Refer to the Section 508 EIT Accessibility Standards available at http://www.access-
board.gov/sec508/standards.htm, the CMS Section 508 Product Assessment, and/or use 
the Buy Accessible Wizard at http://www.buyaccessible.gov/ to assist in determining the 
technical provisions that apply.   Seek assistance from the business component’s CMS 
Section 508 Clearance Officer, the CMS Section 508 Coordinator, or the HHS Office on 
Disability if help is needed to interpret the standards.   
 
If any of the technical provisions are applicable to the purchase request, then the 
Requesting Official (Purchase Requestor) indicates as such in Section 4 of the Section 
508 Determination & Findings for Purchase Requests form, and proceeds to Step 5.   
 
If none of the technical provisions are applicable to the purchase request, then the 
Requesting Official (Purchase Requestor): 

(1.) Completes the certification line for Section 4 of the Section 508 Determination 
& Findings for Purchase Requests form; 

(2.) Completes the Section 508 General EIT Exception Determination & Findings 
Certification form in accordance with the Procedure: Section 508 Exceptions; 
and 

(3.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form and the completed Section 508 General EIT Exception 
Determination & Findings Certification form to the purchase request (i.e., 
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HHS-393 Form or Credit Card Purchase Authorization Form, as applicable) and 
submits the package through the standard CMS procurement process as 
appropriate, thereby completing the procedure for determining Section 508 
compliance for the purchase request. 

  
STEP 5:  If any of the Access Board’s technical provisions are applicable to the purchase 
request, then the Requesting Official (Purchase Requestor) conducts market research in 
accordance with the Procedure: Conducting Market Research to determine the 
availability of compliant products and services in the commercial marketplace.  
 
There may be some products on the market that are partially compliant (i.e., the products 
meet some, but not all, of the applicable standards) or market research may indicate that 
there are no compliant EIT products and services currently available in the commercial 
marketplace.  Market research may also provide pricing information; however, the 
Requesting Official (Purchase Requestor) is not allowed to solicit prices from prospective 
vendors while conducting market research.  Market research may also show that purchase 
of compliant EIT would impose an “undue burden” on the Agency (e.g., the cost of the 
compliant EIT is significantly higher than non-compliant EIT).  Each of these scenarios is 
addressed in the remaining procedural steps. 
 
If as a result of the market research, a commercial product was not found that meets ALL 
of the applicable technical provisions of Section 508 that apply to the purchase request, 
then the Requesting Official (Purchase Requestor) indicates as such in Section 5 of the 
Section 508 Determination & Findings for Purchase Requests form, and proceeds to 
Step 6. 
 
If as a result of the market research, a commercial product was found that meets ALL of 
the applicable technical provisions of Section 508 that apply to the purchase request, then 
the Requesting Official (Purchase Requestor): 

(1.) Completes the certification line for Section 5 of the Section 508 Determination 
& Findings for Purchase Requests form; 

(2.) Has the manufacturer, vendor, or developer of the compliant EIT product 
complete the CMS Section 508 Product Assessment; and 

(3.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form and the completed CMS Section 508 Product Assessment to the 
purchase request (i.e., HHS-393 Form or Credit Card Purchase Authorization 
Form, as applicable) and submits the package through the standard CMS 
procurement process as appropriate, thereby completing the procedure for 
determining Section 508 compliance for the purchase request. 

 
STEP 6:  If from the market research there are no products or services identified that 
meet ALL of the Access Board’s technical provisions applicable to the purchase request, 
then the Requesting Official (Purchase Requestor) determines from the market research if 
a commercial or non-commercial product can be acquired or will be produced in response 
to the solicitation that will meet the applicable technical provisions, and completes 
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Section 6 of the Section 508 Determination & Findings for Purchase Requests form 
accordingly.   
 
If a product is being built or adapted for HHS and/or CMS specifically, then the 
appropriate contractual language requiring, monitoring, and testing conformance to the 
applicable Section 508 technical provisions is to be included in the solicitation.  See 
Appendix A for sample language that should be incorporated into a Statement of Work 
(SOW), Performance Work Statement (PWS), or Task Order (TO) specific to the delivery 
of electronic communications. 
 
If the market research indicates that only products that are partially compliant are 
available in the marketplace, the Requesting Official (Purchase Requestor) may claim 
that the product as a whole is non-available because it does not meet all of the 
accessibility standards, but the Requesting Official (Purchase Requestor) must comply 
with those accessibility standards that can be met that are available in the commercial 
marketplace in time to meet the delivery requirements. 
 
If no commercial or non-commercial product will be produced in response to the 
solicitation that will meet the applicable Access Board technical provisions, then the 
Requesting Official (Purchase Requestor) indicates as such in Section 6 of the Section 
508 Determination & Findings for Purchase Requests form, and proceeds to Step 7. 
 
If a commercial or non-commercial product will be produced in response to the 
solicitation that will meet applicable Access Board technical provisions, then the 
Requesting Official (Purchase Requestor): 

(1.) Completes the certification line for Section 6 of the Section 508 Determination 
& Findings for Purchase Requests form; and 

(2.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form to the purchase request (i.e., HHS-393 Form or Credit Card 
Purchase Authorization Form, as applicable) and submits the package through the 
standard CMS procurement process as appropriate, thereby completing the 
procedure for determining Section 508 compliance for the purchase request. 

 
STEP 7:  If as a result of the market research, a commercial product was not found that 
meets ALL of the applicable technical provisions of Section 508 that apply to the 
purchase request AND a commercial or non-commercial product that meets the technical 
provisions will not be acquired or built/adapted in response to a solicitation, then the 
Requesting Official (Purchase Requestor) completes Section 7 of the Section 508 
Determination & Findings for Purchase Requests form identifying whether or not the 
requirement that is less than fully compliant with Section 508 is a “commercial item” by 
FAR definition.  Refer to Section 7 of the Section 508 Determination & Findings for 
Purchase Requests form for the definition of “commercial item”.  If the purchase is for a 
custom-built product, then a fully documented “Undue Burden” exception is the only 
reason for partial or non-compliance. 
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If the requirement that is less than fully compliant with Section 508 is for a “commercial 
item”, then the Requesting Official (Purchase Requestor) indicates as such in Section 7 of 
the Section 508 Determination & Findings for Purchase Requests form, and proceeds 
to Step 8. 
 
If the requirement that is less than fully compliant with Section 508 is not for a 
“commercial item”, then the Requesting Official (Purchase Requestor): 

(1.) Completes the certification line for Section 7 of the Section 508 Determination 
& Findings for Purchase Requests form; 

(2.) Completes the Section 508 EIT “Undue Burden” Exception Determination & 
Findings Certification form in accordance with the Procedure: Section 508 
Exceptions; and 

(3.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form and the completed Section 508 EIT “Undue Burden” Exception 
Determination & Findings Certification form to the purchase request (i.e., 
HHS-393 Form or Credit Card Purchase Authorization Form, as applicable) and 
submits the package through the standard CMS procurement process as 
appropriate, thereby completing the procedure for determining Section 508 
compliance for the purchase request.  
 

STEP 8:  If the requirement that is less than fully compliant with Section 508 is for a 
“commercial item”, then the Requesting Official (Purchase Requestor) determines from 
the market research if CMS will NOT acquire the available commercial product that best 
meets both the applicable Access Board technical provisions and the Agency minimum 
needs, and completes Section 8 of the Section 508 Determination & Findings for 
Purchase Requests form accordingly.     
 
If CMS will NOT acquire the available commercial product that best meets both the 
applicable Access Board technical provisions and the Agency minimum needs because 
the EIT would impose a significant difficulty or expense on the program or component 
for which the EIT is acquired, then the Requesting Official (Purchase Requestor) 
documents an “Undue Burden” exception.  Note that an “Undue Burden” determination 
may be practical only after the Procurement Official (Contracting Officer) in OAGM has 
received responses to a solicitation. 

(1.) Completes the certification line for Section 8a. of the Section 508 Determination 
& Findings for Purchase Requests form; 

(2.) Completes the Section 508 EIT “Undue Burden” Exception Determination & 
Findings Certification form in accordance with the Procedure: Section 508 
Exceptions; and 

(3.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form and the completed Section 508 EIT “Undue Burden” Exception 
Determination & Findings Certification form to the purchase request (i.e., 
HHS-393 Form or Credit Card Purchase Authorization Form, as applicable) and 
submits the package through the standard CMS procurement process as 
appropriate, thereby completing the procedure for determining Section 508 
compliance for the purchase request. 
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If an “Undue Burden” exception is not determined, then the Requesting Official 
(Purchase Requestor): 

(1.) Completes the certification line for Section 8b. of the Section 508 Determination 
& Findings for Purchase Requests form; 

(2.) Completes the Section 508 EIT “Commercial Non-Availability” Exception 
Determination & Findings Certification form in accordance with the 
Procedure: Section 508 Exceptions; and 

(3.) Attaches the completed Section 508 Determination & Findings for Purchase 
Requests form and the completed Section 508 EIT “Commercial Non-
Availability” Exception Determination & Findings Certification form to the 
purchase request (i.e., HHS-393 Form or Credit Card Purchase Authorization 
Form, as applicable) and submits the package through the standard CMS 
procurement process as appropriate, thereby completing the procedure for 
determining Section 508 compliance for the purchase request. 

 
5.B.   Developed EIT  

The following describes the sequence of steps that comprise the procedure for ensuring 
Section 508 compliance of all EIT developed in-house or pursuant to a contract or 
purchase agreement (e.g., development of information systems or applications).  Refer to 
the CMS Integrated IT Investment & System Life Cycle Framework available at 
http://www.cms.hhs.gov/SystemLifecycleFramework/ for detailed information regarding 
the lifecycle phases, deliverables, and reviews that are identified in the steps that follow. 
 
STEP 1:  During the Concept Phase of the EIT product’s development life cycle, the 
Business Owner ensures that all applicable Access Board technical provisions are 
documented as product requirements in the Requirements Document.   Refer to the 
Section 508 EIT Accessibility Standards available at http://www.access-
board.gov/sec508/standards.htm, the CMS Section 508 Product Assessment, and/or use 
the Buy Accessible Wizard at http://www.buyaccessible.gov/ to assist in determining the 
technical provisions that apply.   Seek assistance from the business component’s CMS 
Section 508 Clearance Officer, the CMS Section 508 Coordinator, or the HHS Office on 
Disability if help is needed to interpret the standards.  The results of EIT market research 
conducted for Section 508 compliance in accordance with the Procedure: Conducting 
Market Research should also be considered and included or referenced in the High-Level 
Technical Design Concept & Alternatives Analysis document as appropriate. 
 
STEP 2:  During the Requirements Analysis Phase of the EIT product’s development life 
cycle, the Business Owner and the System Developer or System Maintainer review and 
revalidate all of the applicable Access Board technical provisions that were previously 
documented in the Requirements Document and make any necessary adjustments before 
establishing the requirements baseline.  The System Developer or System Maintainer 
includes plans for testing or validating compliance with the applicable technical 
provisions (Section 508 requirements) as the Test Plan is drafted and test scenarios and 
success criteria are identified. 
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STEP 3:  During the Design Phase of the EIT product’s development life cycle, the 
System Developer or System Maintainer completes a CMS Section 508 Product 
Assessment for the designed/modified EIT product and includes it as an attachment to 
the System Design Document (SDD).  The completed CMS Section 508 Product 
Assessment is reviewed by the Project Manager, the business component’s CMS Section 
508 Clearance Officer, and/or the CMS Section 508 Coordinator for initial compliancy 
during the Preliminary Design Review (PDR) and/or the Detailed Design Review (DDR).  
The System Developer or System Maintainer will modify the design as necessary to 
ensure that the developed EIT product will be Section 508 compliant, or the Project 
Manager will ensure that the appropriate Section 508 exception is documented and 
approved in accordance with the Procedure: Section 508 Exceptions.  The System 
Developer or System Maintainer and the Project Manager also ensure that plans for 
testing or verifying/validating compliance with the applicable technical provisions 
(Section 508 requirements) are finalized and documented in the Test Plan and that test 
cases are created to test the Section 508 requirements.   
 
STEP 4:  During the Development Phase of the EIT product’s development life cycle, 
the System Developer or System Maintainer ensures that the developed Business 
Product/Code is Section 508 compliant (i.e., meets the Section 508 requirements that 
were documented in the Requirements Document and the initial CMS Section 508 
Product Assessment that was included in the SDD), unless an appropriate Section 508 
exception has been documented and approved.  The System Developer or System 
Maintainer and the Project Manager also ensure that the Test Case Specification includes 
one or more test cases that will test each of the Section 508 requirements to verify 
compliance.    
 
STEP 5:  During the Test Phase of the EIT product’s development life cycle, the OIS-
Designated Testing Resource tests the EIT product in accordance with the documented 
Test Plan and corresponding Test Case Specification, and records the results from the 
testing in a Test Summary Report.  Screen readers and other accessibility tools are 
available to assist in the testing process.  The System Developer or System Maintainer 
fixes any reported defects in the EIT product, and the OIS-Designated Testing Resource 
retests the EIT product for Section 508 compliance, if necessary.  The results from the 
Section 508 testing will serve as input to the Implementation Readiness Review (IRR). 
 
STEP 6:  During the Implementation Phase of the EIT product’s development life cycle, 
the System Developer or System Maintainer prepares a final CMS Section 508 Product 
Assessment for the developed EIT product that will serve as input to the Operational 
Readiness Review (ORR).  During the ORR, the CMS Section 508 Coordinator will 
certify that the EIT product is Section 508 compliant or that the appropriate Section 508 
exception has been fully documented and approved prior to release of the EIT product 
into the production environment.  If the EIT product is determined to not be Section 508 
compliant and an appropriate exception has not been documented and approved, then the 
Project Manager in conjunction with the business component’s CMS Section 508 
Clearance Officer and/or the CMS Section 508 Coordinator must prepare a remediation 
plan for achieving compliance. 
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STEP 7:  During the Operations & Maintenance Phase of the EIT product’s life cycle, 
the existing CMS Section 508 Product Assessment for the EIT product that is operating 
in production must be reviewed and appropriately updated by the manufacturer, vendor, 
or developer for each new release of the EIT product if it is modified, and the new EIT 
product retested by the OIS-Designated Testing Resource for Section 508 compliance, 
and certified by the Project Manager, the business component’s CMS Section 508 
Clearance Officer, and/or the CMS Section 508 Coordinator for compliance prior to the 
revised EIT product’s release into the production environment. 
 
5.C.   Legacy EIT Operating in Production 

The following describes the sequence of steps that comprise the procedure for ensuring 
that legacy EIT that is operating in the CMS production environment (e.g., websites, 
information systems, applications, etc.) that have not been previously evaluated for 
Section 508 compliance are properly evaluated. 
 
STEP 1:  The Business Owner has the manufacturer, vendor, or developer of the EIT 
product complete a CMS Section 508 Product Assessment and gives a copy to the 
Project Manager, the business component’s CMS Section 508 Clearance Officer, and/or 
the CMS Section 508 Coordinator. 
 
STEP 2:  The Project Manager, the business component’s CMS Section 508 Clearance 
Officer, and/or the CMS Section 508 Coordinator reviews the completed CMS Section 
508 Product Assessment for compliance of the EIT product with the Section 508 EIT 
Accessibility Standards.  If the EIT product is determined to be non-compliant, then the 
Project Manager is responsible, within 45 days of the non-compliance determination, for 
developing a remediation plan for achieving compliance or for requesting an applicable 
Section 508 exception in accordance with the Procedure: Section 508 Exceptions. 
 
STEP 3:  If remediation or an exception is determined, the business component’s CMS 
Section 508 Clearance Officer and the CMS Section 508 Coordinator review the 
developed remediation plan or Section 508 exception, as appropriate.  If the remediation 
plan is for achieving Section 508 compliance of non-compliant content published on 
CMS’ public-facing websites and the CMS intranet, the remediation plan must also be 
reviewed by OBIS. 
 
5.D.   Microsoft Word Files 

Since the majority of documents are converted from Microsoft Word to Portable 
Document Format (PDF) files for posting to the Internet and/or Intranet, it is important to 
ensure that the source documents (Microsoft Word files) are Section 508 compliant 
before conversion.  The following is a checklist for assessing each of the requirements 
that must be met for the content of a Microsoft Word document to be deemed Section 508 
compliant.  
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Document Layout and Formatting: 
1. The document has been formatted using Style elements in a hierarchical manner 

(i.e., headings different from body text, etc.). 
2. The document utilizes recommended fonts (i.e., Times New Roman, Verdana, 

Arial, Tahoma, or Helvetica). 
3. If the file is 10 pages or more in length, a Table of Contents (TOC) that is linked 

to sections of the document is included at the beginning of the document. 
4. The document has no flashing/flickering text and/or animated text. 
5. Page numbering codes are used as opposed to manually typed page numbers. 
6. If footnotes are present, they have been created through Word Footnote linking. 
7. If color is used to emphasize the importance of specific text, there is an alternate 

method used to convey the importance as well. 
8. The bullet style is being used as opposed to manually typed characters (e.g., 

hyphens). 
9. If the bullet style is being used, the default round bullet is used. 
10. All edits have been accepted or rejected and all comments have been removed. 
11. Track changes and formatting marks have been turned off. 
12. The document has been reviewed in Print Preview for a final visual check. 
13. All URLs are hyperlinked with the full Web address (e.g., 

http://www.cms.hhs.gov). 
14. All URLs are linked to active Web destinations. 

 
Document Images: 

15. All images and non-text elements have alternative text (Alt Text) descriptions. 
16. All charts and graphs have alternative text descriptions. 
17. Complex images have descriptive text immediately after the image. 
18. The document is free of background images or watermarks. 
19. The image text wrapping style “In Line with Text” is used for all images. 
20. Multiple images are grouped as one object. 
21. Alternate text has been associated with all grouped images. 
22. Text boxes are not being used for simple graphics. 

 
Document Tables: 

23. Tables are used to create a tabular structure (i.e., tabs or spaces are not used to 
display columns of information). 

24. All tables have reading order from left to right, top to bottom. 
25. Tables containing data have the entire first row designated as a ‘header row’ in 

table properties. 
26. Data cells in tables are associated with a ‘header row’. 
27. All tables are described and labeled (captioned). 
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28. In table properties, the option to “Allow row to break across pages” is unchecked 
so that rows will not break across pages. 

 
Additional Requirements: 

29. The document file name does not contain spaces and/or special characters. 
30. The document file name is concise, generally limited to 20-30 characters, and 

makes the contents of the file clear in the context in which it is presented. 
31. The document’s Properties (i.e., Subject, Author, Title, Company, Keywords, and 

Language) are properly completed. 
 
5.E.   Microsoft Excel Files 

The following is a checklist for assessing each of the requirements that must be met for 
the content of a Microsoft Excel file to be deemed Section 508 compliant.  Note that an 
Excel file should not be saved to PDF.  The only way to effectively convert an Excel 
spreadsheet to PDF is to “Copy and Paste” the spreadsheet into Microsoft Word and then 
convert it to a PDF from the Word format. 
 
Document Layout and Formatting: 

1. The document utilizes recommended fonts (i.e., Times New Roman, Verdana, 
Arial, Tahoma, or Helvetica). 

2. Formula cells are indicated by a comment to alert users of their functionality.  The 
comment is the actual formula in the cell so that an Assistive Technology (AT) 
screen reader will alert the user to what it is doing. 

3. Merged cells are only used for formatting purposes within the table header (i.e., 
non-data section of the table).  For example, merging the cells within a table 
header is acceptable (see table example below), but is not acceptable within the 
data area of the table.  Note: The data provided in the table below is used only for 
demonstration purposes and does not represent any actual data.  

 
Office of Information Services 

 EDG BAMG ISDDG EDCG EASG 
FTEs 47 61 72 52 83 
Contractors 6 19 9 23 5 
Other 3 1 0 8 3 

 
4. All tables are prefixed with the table name and table number, if applicable.  This 

information is separated from the actual data table so that an AT screen reader can 
present it prior to reading the data table. 

5. The header rows are formatted to repeat on the top of the table if it goes from one 
page to another.  This will allow an AT screen reader to re-state the header 
information to the user as the table continues from one page to another. 

6. All worksheet cells that contain hyperlinks display the full Web address (e.g., 
http://www.cms.hhs.gov). 
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7. All of the worksheet hyperlinks are linked to active Web destinations. 
8. Track changes and any formatting marks have been turned off. 
9. All edits have been accepted or rejected and all comments have been removed. 
10. All of the active worksheets within a workbook have been given clear and concise 

names to identify the source and contents. 
 
Document Images: 

11. All of the worksheet graphics (images and non-text elements) have alternative 
text (Alt Text) associated with them. 

12. All of the worksheets that have multiple associated images on the same page have 
them grouped as one object. 

13. All worksheets that have grouped images have alternative text (Alt Text) 
associated with the images. 

14. All charts were created in Excel.  If any charts were created outside of Excel, they 
are identified as images and treated as such.  

15. All charts have a Title, Legend, and Axis labels to give users a number of 
reference points to use in order to correctly interpret the information being 
presented. 

16. All complex images (i.e., charts, graphs, flowcharts, etc.) have descriptive text 
immediately after the image. 

 
Document Tables: 

17. All of the worksheets have tables that have a logical layout based on rows and 
columns. 

18. All tables have reading order from left to right, top to bottom. 
19. All tables have clear, concise, and readily identifiable column headers. 
20. All tables have clear, concise, and readily identifiable row headers, if applicable. 
21. There are no merged cells in the tabular data area of the table.  Merged cells are 

only acceptable in the header row of the table. 
22. Row and column headers start in the first left-hand column of the table. 

 
Additional Requirements: 

23. The document file name does not contain spaces and/or special characters. 
24. The document file name is concise, generally limited to 20-30 characters, and 

makes the contents of the file clear in the context in which it is presented. 
25. The document’s Properties (i.e., Subject, Author, Title, Company, Keywords, and 

Language) are properly completed. 
26. A separate text-only version of the document has been provided when there is no 

other way to make the content accessible.  For example, an organizational chart 
must have a text-only version. 
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5.F.   Microsoft PowerPoint Files 

The following is a checklist for assessing each of the requirements that must be met for 
the content of a Microsoft PowerPoint file to be deemed Section 508 compliant.  
 
Document Layout and Formatting: 

1. The document utilizes recommended fonts (i.e., Times New Roman, Verdana, 
Arial, Tahoma, or Helvetica). 

2. All slides were created using the Slide Title placeholder defined within the Slide 
Master. 

3. All slides were created using a Slide Layout template driven by Master Text 
Styles to drive not only the content presentation (i.e., font characteristics), but also 
the content hierarchy (i.e., Heading 1, Heading 2, etc.). 

4. None of the slides have flashing/flickering text and/or animated text. 
5. If color is used to emphasize the importance of specific text, there is an alternate 

method used to convey the importance as well. 
6. All slides that contain hyperlinks (URLs) display the full Web address (e.g., 

http://www.cms.hhs.gov). 
7. All slides that contain hyperlinks (URLs) are linked to active Web destinations. 
8. All slides have their text accessible via the Outline View.  Note that any text 

within text boxes or graphics (with embedded text) are not accessible via the 
Outline View and will not be adequately identified by an AT screen reader.   

 
Document Images: 

9. All slide graphics (images and non-text elements) have alternative text (Alt Text) 
associated with them.  Also note that any images that are included as part of the 
Slide Master will not be accessible to an AT screen reader for interpretation, so 
this practice should be avoided.  Images used only for decoration have null Alt 
Tags. 

10. All slides have multiple associated images on the same page and have them 
grouped as one object. 

11. All slides that have grouped images have alternative text (Alt Text) associated 
with the images. 

12. All charts were created in PowerPoint.  If any charts were created outside of 
PowerPoint, they are identified as images and treated as such.  

13. All slides that have charts on them have Title, Legend, and Axis labels to give 
users a number of reference points to use in order to correctly interpret the 
information being presented. 

14. Complex images (i.e., charts, graphs, flowcharts, etc.) have descriptive text 
immediately after the image.  
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Document Tables: 
15. All tables were created in PowerPoint.  If any tables were created outside of 

PowerPoint, they are identified as images and treated as such. 
16. All tables have a logical layout based on rows and columns, and are oriented so 

that they are read from left to right, top to bottom. 
17. All tables have readily identifiable row and column headings starting in the first 

left-hand column of the table.  Column and row headers are clear and concise to 
assist the reader in identifying the segmentation of the data in the table. 

18. Tables are used to create a tabular structure (i.e., tabs or spaces are not used to 
display columns of information). 

19. All tables are clearly and concisely identified with a name, number (if applicable), 
and a description of the tables’ contents to help clarify the purpose of the table 
and identify its relationship to the presentation. 

 
Additional Requirements: 

20. The document file name does not contain spaces and/or special characters. 
21. The document file name is concise, generally limited to 20-30 characters, and 

makes the contents of the file clear in the context in which it is presented. 
22. The document’s Properties (i.e., Subject, Author, Title, Company, Keywords, and 

Language) are properly completed. 
23. A separate text-only version of the document has been provided when there is no 

other way to make the content accessible.  For example, an organizational chart 
must have a text-only version. 

 
5.G.   Portable Document Format (PDF) Files 

The following describes the sequence of steps that comprise the procedure for ensuring 
that a PDF file is Section 508 compliant and fully accessible using Adobe Acrobat 
Professional 8.0 or a later version of the software. 
 
STEP 1:  Open the PDF document that is to be evaluated by choosing File > Open.  
Choose File > Properties and select the “Advanced” tab to ensure that the “Language” 
field that appears under “Reading Options” is properly set.   Also review the 
“Description” tab to ensure there is appropriate information in the Title, Author, Subject, 
and Keywords fields and that the document is a “Tagged PDF”.  
 
STEP 2:  Ensure that the page properties of the document have been properly set to help 
ensure proper reading order by an AT screen reader.  Choose View > Navigation Panels 
> Pages to check the properties for each of the pages of the document.  As depicted in 
Figure 1, select each page in the left frame of the screen, click on the “Options” menu in 
that frame, and select “Page Properties” that appears at the bottom of the displayed 
window of options.  
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Figure 1 – Sample Page Properties View 
 
The “Page Properties” window will then be displayed as depicted below in Figure 2.  
Ensure that the “Tab Order” of the document page is set properly.  Generally, most PDF 
documents should be set to “Use Document Structure” as depicted in Figure 2.  Close the 
Page Properties / Tab Order options window when finished.  Complete this step for each 
page in the PDF document. 
 

 
 
Figure 2 – Page Properties / Tab Order Option Window 
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STEP 3:  To check the accessibility of the PDF document, choose Advanced > 
Accessibility > Full Check and click OK.   A window of available options will then be 
presented as depicted below in Figure 3.  Make sure that the following “Report and 
Comment Options” and “Page Range” options are checked as depicted in Figure 3: 

• Create Accessibility Report 
• Include repair hints in Accessibility Report 
• All pages in document 

Also make sure that all of the available “Checking Options” are selected as depicted in 
Figure 3, and then click “Start Checking,” which appears in the lower right corner of the 
window. 
 

 
 

Figure 3 – Adobe Acrobat Accessibility Full Check Options Window 
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STEP 4:  Adobe Acrobat Professional will present a summary report indicating either 
that the checker found no problems with the document or will list the problems that were 
found which may prevent the document from being fully accessible.  Click OK in the 
lower right corner of the summary report window and a full accessibility report will be 
presented that identifies the accessibility errors in detail and provides hints for how to 
repair them.   
 
As much as possible, the accessibility errors reported by Adobe Acrobat Professional 
should be corrected in the original source file (e.g., the original Microsoft Word file in 
accordance with Section 5.D. of this procedure or the Microsoft PowerPoint file in 
accordance with Section 5.F. of this procedure).  The PDF file should then be re-created 
and re-evaluated for Section 508 compliance. 
  
STEP 5:  Evaluate the reading order of the PDF using the Read-Out-Loud feature in 
Adobe Acrobat Professional to help ensure that the PDF will function properly when read 
by an AT screen reader.  Though not an actual AT screen reader, the Read-Out-Loud 
feature makes it easy for PDF files to be read by your computer as long as the 
information in the document is tagged.  The tagging information in the PDF file tells a 
screen reader and other assistive technology devices how to treat the text blocks, 
paragraphs, etc., to infer a logical sequence for reading.    
 
You can read aloud as much of a PDF document as you need: a page or the entire 
document.  To read a particular page, choose View > Read Out Loud > Activate Read 
Out Loud.  Make sure that the volume control on your computer is turned up sufficiently 
for you to hear what is being read.  Choose either View > Read Out Loud > Read This 
Page Only or Read To End of Document to begin reading the document out loud. 
 
If the reading order is not as expected, select View > Navigation Panels > Order to view 
the current sequential order of the items appearing on the specific page.  If the order of 
the items on the page is not as it should be and needs to be changed, select the displaced 
item from the “Order” tab (see example depicted below in Figure 4) and drag it into the 
proper location.  The reading order will be adjusted accordingly and can be rechecked 
using the Read-Out-Loud feature.  
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Figure 4 – Sample Reading Order Window 
 
The following is a checklist for assessing each of the requirements that must be met for 
the content of a PDF file to be deemed Section 508 compliant.  
 
Document Layout and Formatting: 

1. The document utilizes recommended fonts (i.e., Times New Roman, Verdana, 
Arial, Tahoma, or Helvetica). 

2. The document has a logical reading order (i.e., the tab order is correct). 
3. The document contains functioning bookmarks and/or a Table of Contents for 

internal navigation if the document is 10 pages or longer. 
4. All hyperlinks (URLs) are displayed with the full Web address (e.g., 

http://www.cms.hhs.gov). 
5. All hyperlinks (URLs) are linked to active Web destinations. 
6. All comment and markup items have been removed from the document. 
7. Acrobat accessibility tags have been added to the document as part of the 

conversion process and have been visually verified. 
8. A full Accessibility Report has been run on the document in Adobe Acrobat 

Professional 8 or higher showing no errors are present. 
9. Multi-column text, tables, and/or call-out boxes have been checked for correct 

reading order using the Adobe Acrobat Professional Read-Out-Loud feature. 
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Document Images: 
10. The document has no scanned images of text. 
11. All images and non-text elements have alternative text (Alt Text) descriptions. 
12. All charts and graphs have alternative text descriptions. 
13. Complex images have descriptive text immediately after the image. 
14. Multiple images are grouped as one object. 
15. Alternate text has been associated with all grouped images. 

 
Document Tables: 

16. All tables have a logical layout based on rows and columns, and are oriented so 
that they are read from left to right, top to bottom. 

17. All tables have readily identifiable row and column headings starting in the first 
left-hand column of the table.  Column and row headers are clear and concise to 
assist the reader in identifying the segmentation of the data in the table.   

18. All data cells in the tables are logically associated with the header row (i.e., there 
is a logical, one-to-one association from the data to the information in the header 
row). 

19. All table cells, with the exception of those associated with the header row, are 
designated as data cells. 

20. Tables are used to create a tabular structure (i.e., tabs or spaces are not used to 
display columns of information). 

21. All tables are clearly and concisely identified with a name, number (if applicable), 
and a description of the tables’ contents. 

 
Additional Requirements: 

22. The document file name does not contain spaces and/or special characters. 
23. The document file name is concise, generally limited to 20-30 characters, and 

makes the contents of the file clear in the context in which it is presented. 
24. The document’s properties have been properly completed, the proper language 

has been specified, and the document is determined to be a “Tagged PDF”. 
25. A visual check has been performed on the document to ensure that no hidden data 

from the original source file used to create the PDF (e.g., Microsoft Word, 
Microsoft PowerPoint, etc.) is present in the PDF file. 

26. A separate text-only version of the document has been provided when there is no 
other way to make the content accessible.  For example, an organizational chart 
must have a text-only version. 

27. An HTML version of the document is available if the PDF version cannot be 
made Section 508 accessible. 

28. The document does not contain any scanned signatures, which would be 
considered a security risk.  If a signature is needed, it is indicated via an alternate 
method (e.g., /s/). 
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6. EFFECTIVE DATES 

This procedure becomes effective on the date that the CMS Section 508 Official signs it, 
and remains in effect until officially superseded or cancelled by the CMS Section 508 
Official.   
 

7. INFORMATION AND ASSISTANCE 

For further information and/or assistance regarding this procedure, please contact the 
CMS Section 508 Coordinator located in the Office of Information Services (OIS). 
 

8. APPROVED 

 
 
                    /s/                                             7/16/2008                                   
 
Julie C. Boughn Date of Issuance 
CMS Section 508 Official 
 

9. ATTACHMENTS 

The following documents augment this procedure: 
 
• Procedure: Conducting Market Research 
• Procedure: Section 508 Exceptions 
• Form: Section 508 Determination & Findings for Purchase Requests 
• Form: Section 508 General EIT Exception Determination & Findings 

Certification 
• Form: Section 508 EIT “Undue Burden” Exception Determination & Findings 

Certification 
• Form: Section 508 EIT “Commercial Non-Availability” Exception Determination 

& Findings Certification 
• Form: CMS Section 508 Product Assessment 
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APPENDIX A – CONTRACT LANGUAGE 

Section 508 Compliance for Communications 
 
The <name of system, website, or product> shall comply with the standards, policies, and 
procedures below.  In the event of conflicts between the referenced documents and this 
<SOW, PWS, or TO>, the <SOW, PWS, or TO> shall take precedence. 
 
Rehabilitation Act, Section 508 Accessibility Standards 

1. 29 U.S.C. 794d (Rehabilitation Act, as amended) 
2. 36 CFR 1194 (508 Standards) 
3. http://www.access-board.gov/sec508/508standards.htm (508 Standards) 
4. FAR 39.2 (Section 508) 
5. CMS/HHS standards, policies, and procedures (Section 508) 

 
In addition, all contract deliverables are subject to these 508 standards as applicable. 
 
Regardless of format, all Web content or communications materials produced, including 
text, audio or video - must conform to applicable Section 508 standards to allow federal 
employees and members of the public with disabilities to access information that is 
comparable to information provided to persons without disabilities. All contractors 
(including subcontractors) or consultants responsible for preparing or posting content 
must comply with applicable Section 508 accessibility standards, and where applicable, 
those set forth in the referenced policy or standards documents <above/below>. 
Remediation of any materials that do not comply with the applicable provisions of 36 
CFR Part 1194 as set forth in the <SOW, PWS, or TO>, shall be the responsibility of the 
contractor or consultant. 
 
The following Section 508 provisions apply to the content or communications material 
identified in this <SOW, PWS, or TO>: 
 
36 CFR Part 1194.22 a – j, l – p 
 
36 CFR Part 1194.41 a – c 
 

http://www.access-board.gov/sec508/508standards.htm
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